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1. Welcome to COPA-DATA help

GENERAL HELP

If you cannot find any information you require in this help chapter or can think of anything that you
would like added, please send an email to documentation@copadata.com
(mailto:documentation@copadata.com).

PROJECT SUPPORT

You can receive support for any real project you may have from our Support Team, who you can contact
via email at support@copadata.com (mailto:support@copadata.com).

LICENSES AND MODULES

If you find that you need other modules or licenses, our staff will be happy to help you. Email
sales@copadata.com (mailto:sales@copadata.com).

2. Tools

A range of tools support you for the management, analysis and configuration of zenon:

» Diagnosis Viewer (on page 6): Allows zenon LOG files to be read and configured.

» Keyblock Runtime Start (on page 52): Starts zenon Runtime and at the same time blocks all

Windows system keys.

» Online updating of the zenon Help (on page 55): Allows online updating of zenon Help.
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» Project Translation Interface: (on page 58) Tool for the translation of zenon language files. Opens
or saves data for the zenon Language Translation Wizard. With this, projects can be imported

into or exported out of zenon.

» Startup Tool (on page 64): Makes it possible to start the Editor and Runtime with certain
parameters, to administer different zenon versions on one computer, to administer SQL

instances and to define languages for Editor and Runtime.

» System Information Collector (on page 88): Reads system information and zenon information,

displays it in an output window and saves it as a ZIP file.

The following are available for zenon Logic:

» zenon Logic Runtime Manager: Administer all stand-alone/manual-start zenon Logic Runtime
projects on your computer.

The documentation for this tool is part of the zenon Logic documentation.

2.1 Diagnosis Viewer

All zenon modules such as Editor, Runtime, drivers, etc. write messages to a joint log file. You can read
and configure them with the Diagnosis Viewer which is installed together with zenon. It allows the
reading of existing log files, online logging, saving of the current view, parameterizing the Diagnosis

Clients and the Diagnosis Server. You can find it under Start/All programs,/zenon/Tools 7.10 -> Diagnosis
Viewer.

The Diagnosis Viewer is only available in English.

3 License information

Part of the standard license of the Editor and Runtime.

USING IPV6

The Diagnosis Server also works with Diagnosis Clients which addresses via IPv6 addresses. For this the
format of the log file has been adapted. The Diagnosis Viewer only reads the new format of the log files.
If files from older zenon versions are opened (or vice versa), the IP address of the Diagnosis Client is not
displayed correctly.



DRIVER ANALYSIS

zenon driver log all errors in the log files. The default folder for the log files is subfolder LoG in directory
ProgramData, example: C: \ProgramData\zenon\zenon7.10\LOG for zenon Version 7.10.
Log files are text files with a special structure.

Attention: With the default settings, a driver only logs error information. With the Diagnosis Viewer
you can enhance the diagnosis level for most of the drivers to "Debug" and "Deep Debug". With this the
driver also logs all other important tasks and events.

In the Diagnosis Viewer you can also:

» follow currently created entries live
» customize the logging settings

» change the folder in which the log files are saved

1. In Windows CE even errors are not logged per default due to performance reasons.
2. The Diagnosis Viewer displays all entries in UTC (coordinated world time) and not in local time.

3. The Diagnosis Viewer does not display all columns of a log file per default. To display more
columns activate property Add all columns with entry in the context menu of the column

header.

4. If youonly use Error logging, the problem description is in column Error text. For other

diagnosis level the description is in column General text.

5. For communication problems many drivers also log error numbers which the PLC assigns to
them. They are displayed in Exrror text and/or Exror code and/or Driver error
parameter (1 and 2). Hints on the meaning of error codes can be found in the driver

documentation and the protocol/PLC description.

6. Atthe end of your test set back the diagnosis level from pebug or beep Debug. At Debug and
Deep Debug there are a great deal of data for logging which are saved to the hard drive and
which can influence your system performance. They are still logged even after you close the

Diagnosis Viewer.



2.1.1 General

The zenon diagnosis system consists of three parts:

» Diagnosis Server (on page 22): local or or defined in zenon6.ini defined Logszv
» Diagnosis Clients (on page 27): all modules, drivers, services, etc. which write messages

» Diagnosis Viewer (on page 31): Analysis program

VERSIONS

From version 7.00 on the service zenLogsrv is used instead of the zensyssrv for the diagnosis system.
That means:

» Diagnosis systems up to version 6.51 and from version 7.00 are each compatible among

themselves.

» The diagnosis mechanism of zenon 6.51 SPO and zenon 7.00 SPO are not compatible.

Compatibility Diagnosis Server 6.51 SPO Diagnosis Server 7.00 SPO
and earlier and higher

Diagnosis Client 6.51 SPO and earlier compatible incompatible

Diagnosis Viewer 6.51 SPO and earlier compatible incompatible

Diagnosis Client 7.00 SPO and higher incompatible compatible

Diagnosis Viewer 7.00 SPO and higher incompatible compatible

With the Diagnosis Viewer version 7.00 SPO and higher you can open log files which were created by
Diagnosis Server version 6.51 SPO (or earlier). It does not work the other way round.

DEFAULT PORTS
» Version 7 and higher: 50780 (port of service zenLogSrv)

» upto6.51: 1101 (port of service zenSysSrv)

If the port cannot be opened, the service closes itself.



A Attention

If the port to which the Diagnosis Viewer should connect is closes, then it is tried to start
the local Diagnosis Server. This makes sure that local logging is carried out if no

Diagnosis Server is available in the network.

MEMORY OCCUPANCY

Service zenLogSrv buffers log entries until they can be written in the log file. If the memory
consumptions increases continuously by zenLogsrv, it is an indicator that the log file cannot be written.

2.1.2  Topology of the diagnosis system

The topology of the diagnosis system differs for versions up to 6.51 SPO and from 7.00 SPO on.

TOPOLOGY BEFORE ZENON 7.00 SPO

The diagram displays all possible connections for which zensyssrv is responsible. Each arrow represents
a network connection between the applications. All applications connect to the zensyssrv on port
1101 regardless of whether Client and Server are on the same computer or communicate with each
other via a network.

o/

zenSysSrv
[

3

v

|Diagnose Clients. -

1. The Editor sends log entries, commands and data of the Remote Transport to zensyssrv.
zenSysSrv sends the configuration of the Diagnosis Clients (Editor, Runtime, driver, web server,

web client, etc.) and the Remote Transport data to the Editor.

2. The Diagnosis Viewer sends diagnosis commands, diagnosis configurations and log entries to
zenSysSrv. zenSysSrv sends diagnosis data and the Diagnosis Client configuration to the

Diagnosis Viewer.



3. zenSysSrv sends the Diagnosis Client configuration to the Diagnosis Clients. The Diagnosis

Clients send log entries to zenSysSrv.

zenSysSrv reacts correspondingly to each incoming message:

» Log entries are written in log files.
» Remote Transport commands (start Runtime, write/read back data, etc.) are executed.

» Diagnosis commands (set Server/Client configuration, start online logging, etc.) are executed.

TOPOLOGY AS OF ZENON 7.00 SPO

The diagram displays all possible connections for which zensyssrv and zenLogsrv (as of version 7.00
SPO0) are responsible. Each arrow represents a network connection between the applications. All
applications connect to zenLogsrv on port 50780. The editor connects to zenSyssrv on port 1101. It is
regardless of whether Client and Server are on the same computer or communicate with each other via
a network.

Diagnose Viewer
b
1 3
A
zenSysSrv |« 7 »{ zenLogSrv

Diagnose Clients

1. The Editor sends commands and data of the Remote Transport to zenSysSrv. zenSysSrv sends

data of the Remote Transport to the Editor.

2. The Editors send log entries to zenLogSrv. zenLogSrv sends the Diagnosis Client configuration
to the Editor.

3. The Diagnosis Viewer sends diagnosis commands, diagnosis configurations and log entries to
zenSysSrv. zenSysSrv sends diagnosis data and the Diagnosis Client configuration to the

Diagnosis Viewer.

4. The zensyssrv sends log entries to the zenLogSrv. zenLogSrv sends the Diagnosis Client

configuration to zensyssrv.

5. zenLogsrv sends the Diagnosis Client configuration to the Diagnosis Clients. The Diagnosis

Clients send log entries to zenLogSrv.
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zenSysSrv reacts to: incoming Remote Transport commands.
zenLogSrv reacts to incoming diagnosis commands and log entries

EXAMPLE

IN an environment with a central Diagnosis Server the Runtime is started on a device. Based on the
Runtime version the configuration is read from zenoné6.ini. Versions before 7.00 SPO read entry

LOG CONFIG from [sYs_REMOTE], later versions read this entry from [LOGGING SYSTEM]. This
configuration is used to establish a diagnosis connection. (For details see Standard procedure (on page
11).) Each additional component loaded by the Runtime (driver, zenNetsrv, etc.) also establish a
diagnosis connection.

2.1.3  Standard process
As default only error messages (errors) are sent from the Clients to the Diagnosis Server.

The Diagnosis Server saves the received messages in TXT files with a special structure (on page 48). The
default folder for the log files is subfolder r.oG in directory ProgramData. For example:
$ProgramData%$\COPA-DATA \LOG

For more information see manual Installation and Updates chapter File structure.

Note: Under Windows CE error messages are also not created per default due to resource issues.

In order to report not only error messages to the Diagnosis Server but also other information important
for the diagnosis, the according settings have to be defined for the Client (on page 27).

You can also configure the behavior of the Server (on page 22).

CONFIGURATION

The configuration of the connection is done in zenon6.inl (on page 13) divided in:

» Diagnosis Clients
» Diagnosis Server

» Versions to make sure that the configuration of the versions does not affect each other

The configuration of the Diagnosis Viewer (on page 31) also enables you to configure settings for the
connection:
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» Settings of the server (on page 24)
» Connection settings Diagnosis Server connection (on page 33)
» Diagnosis Client (on page 27)

» Diagnosis Viewer - Analysis Program (on page 31)

We recommend to do the configuration of the connection for Server and Client via zenon6.ini.

PROCEDURE

The Diagnosis Server is:

» aservice at the PC.

The service starts automatically when the operating system boots. The local service can only be
started once.

» an application under CE.
Under CE only one process can use the port. Additionally started processes terminate
themselves as the port cannot be opened. If the local configuration of the Diagnosis Server is set
under CE in such a way that only the user interface is displayed (INIT=2), several processes could

emerge by the Diagnosis Clients trying to start the local Diagnosis Server.

As soon as a Diagnosis Client gets active, the following steps are carried out:

1. The Diagnosis Client reads and uses the configuration from zenoné6. ini. If no configuration is
available in zenoné6. ini, the default configuration (Diagnose

Server=localhost:50780)is used.

2. The Diagnosis Client tries to establish a connection to the Diagnosis Server:

Establishing successful:

a) The diagnosis connection has been established and the log entries are sent.

Establishing failed:

b) The Diagnosis Client tries to start and use the local Diagnosis Server.
On a PC it tries to start the service.
Under CE it tries to create the process.

c) The Diagnosis Client tries to establish a connection to the local Diagnosis Server. If it
succeeds, the diagnosis connection is established and the log entries are sent.

If it fails, no log entries are created.

12



Entries in zenon6.ini

The configuration of zenSysSrv and zenLogSrv is carried out via zenon6.ini. At this it is differentiated
between version 7.00 and up and versions 6.51 and earlier. With this you can configure old and new
Diagnosis Clients and Diagnosis Servers independent of each other on one device. For example, the LOG
entries of old Diagnosis Clients are diverted, without the LOG entries of new clients being affected.

13



DIAGNOSIS SERVER BEFORE VERSION 7.00 SPO

INI entry

[SYS_REMOTE]

LOGDirectory=

CONFIG=

LOGMinFreeDiskSpac
e:

Description

Section in zenoné6.ini.

Contains parameters for zenSysSrv (Remote Transport and Diagnosis Server).

Defines folder for the LOG files.

If there is no entry, the LOG folder in the ProgramData folder is used as a
default value.

Example:
LOGDirectory= %$ProgramData%\COPA-
DATA\zenon651\LOG

Configuration string for the Diagnosis Server and zenSysSrv. Remote
Transport and the diagnosis system use the same server configuration up to
and including version 6.51 SPO. The string consists of the following parts:

DEVICE=[Device];HOST=[Hostname] ; PORT=[Port]; TIME

OUT=[Timeout]

»  DEVICE: Sets the communication type used.
TCP/IPand serial areavailable.

> HOST: Is set to the computer name of the Diagnosis Server.
»  PORT: states the port to be used.
»  TIMEOUT: Provides the time-out time for the connection is seconds.
> BAUD: Provides the connection speed of a serial connection.
PC configuration:
» DEVICE=TCP/IP
» HOST=localhost
> PORT=1101
>  TIMEOUT=10
CE configuration:
> DEVICE=COM1
» BAUD=115200

Defines minimum memory (in MB) that must be available on the hard drive.
LOG files are deleted before this value is gone below.

14



LOGMaxUsedDiskSpac
e:

LOGMinUsedDiskSpac
e=

LOGLogLifeTime=

LOGImageCnt=
LOGLogUpdateTime=
iOGMaxBufferedRecs
LOGMaxLogFileSize=

LOGCheckDiskTime=

INIT=

Default: 1024

Defines the maximum memory on the hard drive in MB used for LOG files. LOG
files are deleted if this value is exceeded.

Default: 1024

Defines memory on the hard drive (in MB) that is used even if there are no
LOG files.

Default: 5
Defines the lifecycle of the LOG files in seconds. Older LOG files are deleted.
Default: 1209600 (corresponds to 14 days)

Defines the number of LOG entries, after which all incremental LOG files are
written.

Default: O

Number of milliseconds, after which the LOG entries received are written to a
LOG file.

Default: 2000

Defines the number of LOG entries that are buffered if they cannot be written
to files.

Default: 10240

Maximal size of a log file in bytes. If a log file reaches this size, it is closed and a
new log file is created.

Default: 5242880 (corresponds to 5 MB)

Defines the interval in seconds, in which the memory occupied by LOG files is
checked.

Default: 60
Action when starting the application with Windows CE:

» 0:endimmediately
» 1 (or other value greater than 2): Open listening port in minimize to system tray
»  2:only display surface

Default: 1

Note: As part of the separation of zenSysServ and zenLogServ for zenon 7.00,

15



this default value was also changed for other versions. The default value was
previously 2.

DIAGNOSIS SERVER FROM VERSION 7.00 SPO

INI entry

[LOGGING_SYSTEM]

LOGDirectory=

CONFIG=

LOGMinFreeDiskSpa

ce=

Description

Section in zenoné6.ini.

Contains parameters for the Diagnosis Server. Only affects zenLogSrv and has
no effect on zenSysSrv.

Defines folder for the LOG files.
If there is no entry, the following is used as a standard value:

The path extracted from the Registry,
for example: %ProgramData%\COPA-DATA\LOG

the LOG folder in the ProgramData folder of the zenLogSrv, if no path is
defined in the registry,
e.g. $ProgramData%\COPA-DATA\zenon700\LOG

Configuration string for the Diagnosis Server. The string consists of the
following parts:

DEVICE=TCP/IP; HOST=[Hostname] ; PORT=[Port]; TIMEOU
T=[Timeout]

> DEVICE: Sets the communication type used and must always be setto TCP/IP
> HOST: Is set to the computer name of the Diagnosis Server.
>  PORT: states the port to be used.

> TIMEOUT: Provides the time-out time for the connection is seconds.

Configuration:
»  DEVICE=TCP/IP
> HOST=localhost
»  PORT=50780

> TIMEOUT=10

Defines minimum memory (in MB) that must be available on the hard drive.
LOG files are deleted before this value is gone below.

Default: 1024

16



LOGMaxUsedDiskSpa
ce=

LOGMinUsedDiskSpa
ce=

LOGLogLifeTime=

LOGImageCnt=

LOGLogUpdateTime=

LOGMaxBufferedRec
S:

LOGMaxLogFileSize

LOGCheckDiskTime=

INIT=

Defines the maximum memory on the hard drive in MB used for LOG files. LOG
files are deleted if this value is exceeded.

Default: 1024

Defines memory on the hard drive (in MB) that is used even if there are no
LOG files.

Default: 5
Defines the lifecycle of the LOG files in seconds. Older LOG files are deleted.
Default: 1209600 (corresponds to 14 days)

Defines the number of LOG entries, after which all incremental LOG files are
written.

Default: 0

Number of milliseconds, after which the LOG entries received are written to a
LOG file.

Default: 2000

Defines the number of LOG entries that are buffered if they cannot be written
to files.

Default: 10240

Maximal size of a log file in bytes. If a log file reaches this size, it is closed and a
new log file is created.

Default: 5242880 (corresponds to 5 MB)

Defines the interval in seconds, in which the memory occupied by LOG files is
checked.

Default: 60
Action when starting the application with Windows CE:

» 0O:endimmediately
» 1 (or other value greater than 2): Open listening port in minimize to system tray
»  2:only display surface

Default: 1

DIAGNOSIS CLIENT BEFORE VERSION 7.00 SPO:

17



Tools

Zzenon

[SYS_REMOTE]

Section in zenon6.ini.

Contains parameters for the Diagnosis Client.

LOG_CONFIG=

A configuration string for the Diagnosis Client is stored here. The string consists
of the following parts:

DEVICE=TCP/IP;HOST=[Hostname] ; PORT=[Port]; TIMEOU
T=[Timeout]

> DEVICE: Sets the communication type used and must always be setto TCP/IP
> HOST: Is set to the computer name of the Diagnosis Server.
»  PORT: states the port to be used.

»  TIMEOUT: Provides the time-out time for the connection is seconds.

Configuration:

» DEVICE=TCP/IP
»  HOST=localhost
) PORT=1101

»  TIMEOUT=10

DIAGNOSIS CLIENT FROM VERSION 7.00 SPO

[LOGGING_SYSTEM]

Section in zenoné6.ini.

Contains parameters for the Diagnosis Client.

LOG_CONFIG=

A configuration string for the Diagnosis Client is stored here. The string consists
of the following parts:

DEVICE=TCP/IP; HOST=[Hostname] ; PORT=[Port]; TIMEOU
T=[Timeout]

> DEVICE: Sets the communication type used and must always be setto TCP/IP
»  HOST: Is set to the computer name of the Diagnosis Server.
> PORT: states the port to be used.

»  TIMEOUT: Provides the time-out time for the connection is seconds.




Configuration:

>  DEVICE=TCP/IP
»  HOST=localhost
»  PORT=50780

> TIMEOUT=10

HINTS

INIT UNDER CE

Under Windows CE we urgently recommend to not set entry INIT= (in section [LOGGING_SYSTEM] or
[SYS_REMOTE]) to value 2.

Reason: The value 2 means that both the syssrvcE and the LogszvCE only display the user interface
and not open the listening port.

If now a Diagnosis Client wants to establish a connection, it will fail. As in this case the Diagnosis Clients
start process LogsrvCE and the process does not open the port, each Diagnosis Client starts such a
process. This leads to several parallel LogSrvCE processes and to a delay in starting the Diagnosis Clients
as it waits for the timeout of the connection while establishing the diagnosis connection.

ZENLOGSRV ON A SYSTEM WITH DIFFERENT VERSIONS

If zenLogsrv is used on a system with different versions as a central local diagnosis server, the entry
LOG_CONFIGinthe [sYs_REMOTE] such must be as follows:
DEVICE=TCP/IP;HOST=1localhost; PORT=5780; TIMEOUT=10

Reason: Older clients then use zenLogsrv as the Diagnosis Server. New clients do this automatically.
This service is switched on automatically on the PC when the system is started; it must be started
manually with CE.

Attention: If the port cannot be reached, older clients start zensyssrv and retry connecting to it.

Windows CE

Under Windows CE the Diagnosis Server is started as an application.
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At the configuration (on page 13) of the connection consider the recommendation for parameter INIT:

Under Windows CE we urgently recommend to not set entry INIT= (in section [LOGGING_SYSTEM] or
[SYS_REMOTE]) to value 2.

Reason: The value 2 means that both the syssrvcCE and the LogsrvcCE only display the user interface
and not open the listening port.

If now a Diagnosis Client wants to establish a connection, it will fail. As in this case the Diagnosis Clients
start process LogSrvCE and the process does not open the port, each Diagnosis Client starts such a
process. This leads to several parallel LogSrvCE processes and to a delay in starting the Diagnosis Clients
as it waits for the timeout of the connection while establishing the diagnosis connection.

USER INTERFACE UNDER CE

TRANSPORT SERVICE (ZENSYSSRV)

i 1 ' Transport Service &J‘
l Start l ‘ Browse ‘ ‘ Stop ‘
Configuration:

‘ Hide ‘
| Bt |
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Parameters

Start

Browse

Stop

Configuration

Hide

Exit

X
(button top right)

Description

Opens the Listening port and enables zensyssrv to receive
Remote Transport commands.

Opens the dialog for browsing the file system.

Terminates the receiving of Remote Transport commands and
closes the Listening port.

Selection of an existing server configuration from drop-down list.

New connections cannot be configured. See section Entries in
zenonb.ini (on page 13) for the configuration of the connection.
Available are:

»  Configuration from zenon6.ini
»  Standard configuration for TCP/IP
»  Standard configuration for COM1 to COM4

Minimizes the user interface to the system tray.

Terminates the application and closes the Listening port if
necessary.

Minimizes the user interface to the system tray.

LOGGING SERVICE (ZENLOGSRV)

i ' Logging Service

o]

Configuration:

Stop

‘ Hide

‘ Exit
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Parameters Description

Start Opens the Listening port and enables zenLogsrv to receive log
entries.

Stop Terminates the receiving of log entries and closes the Listening
port.

Configuration Selection of an existing configuration from drop-down list. New

connections cannot be configured. See section Entries in
zenonéb.ini (on page 13) for the configuration of the connection.
Available are:

»  Configuration from zenoné6.ini

»  Standard configuration for TCP/IP

Hide Minimizes the user interface to the system tray.

Exit Terminates the application and closes the Listening port if
necessary.

X Minimizes the user interface to the system tray.

(button top right)

2.1.4 Diagnosis Server

The Diagnosis Server:

» Creates and manages log files.

» The Server is:
e implemented from zenon 7.00 on as zenLogSrv

e up until zenon 6.51 integrated in the zenSysSrv.
» The configuration of the server is read from the zenoné6.ini (on page 13).
» The server writes the received log data into the log file.

» The saving location for the files has to be configured. Standard: $ProgramData$\COPA-
DATA\LOG\
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» Log files are named after the following fashion LOGKYYMMTThhmmss>. txt.
» The serveris multi client able. Several evaluations can connect to the server simultaneously.
» Itis possible to connect to the server online, to see the current logging messages.

» Itis possible to connect to diagnosis servers other than the local and to execute the same tasks

(configuring server, configuring clients, online logging) as on the local server.

» The parameters of the current server (with which the Diagnosis Viewer is connected) can be
modified. If a modification of another diagnosis server is needed, the server connection can be

changed in the menu under File - Connect to....

» The menu entry settings - Server configuration is only available, if online logging is not

used at the moment.

System integrity monitoring

At the start of the Runtime a monitoring thread with high priority is also started. The monitoring thread
checks critical parameters every ten seconds and writes corresponding warnings or errors in module
Supervisor of the Diagnosis Server.

The following parameters are monitored.
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Parameters Limit

Warning threshold for used handles > 5000
Error threshold for used handles > 9000
Warning threshold for used GDI objects > 5000
Error threshold for used GDI objects >9000
Warning threshold for CPU use for the main thread >70%
Error threshold for CPU use for the main thread >90 %
Warning threshold for total CPU use >70 %
Warning threshold for total CPU use >90 %
Warning threshold for free main memory <30%
Error threshold for free main memory <10 %
Warning threshold for OnTimer in the main frame > 1000 ms
Error threshold for OnTimer in the main frame > 5000 ms

Settings of the server

The Diagnosis Server can be configured via entries in file zenon6.ini or via dialog server configuration
in the Diagnosis Client. We recommend to do the settings in file zenon6.ini.

CONFIGURATION VIA ZENONG.INI

See section Entries in zenon6.ini (on page 13).

CONFIGURATION VIA DIALOG

To configure the Diagnosis Server via the dialog:

1. start the Diagnosis Viewer

2. open entry File Connect to... (on page 33).
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3. configure the desired Server

(Take care of the correct port selection depending on the version!)
4. open entry Settings -> Server configuration
5. configure the events which should be logged

6. Close the dialog by clicking on ok

Note: All changes are written to zenon6. ini when the dialog is confirmed.

Configuration of the events which should be logged by the Diagnosis Viewer:

r ~
Diagnosis server configuration @
Messagelevel
Modules LOGImageCnt 0
GENERAL Errors e 18]
LOGMinFreeDiskSpace [MB:
NET |:| Warnings 1024
PROXY .
o8 [ Success LOGMaxUsedDiskSpace [MB] 1024
SYSSRY [ Failed LOGMinUsedDiskSpace [ME] 5
DRV
LoG [ internal LOGLogUpdateTIme [ms] 2000
[[Message LOGMaxBufferdRecs 10240
[Cpebug LOGMaxLogFileSize [BYTE] 5242330
7| Deep Debug .
LogDirectory C:\ProgramData\COPA-DATALOG (]
LOGLogLifeTime [s] 1209600
LOGCheckDiskTime 50
Message level for all modules ] [ Default values ] [ Accept ] [ Cancel ] [ Ok




Parameter

Modules

Message level

LOGImageCnt

LOGMinFreeDiskSpa
ce

LOGMaxUsedDiskSpa
ce

LOGMinUsedDiskSpa
ce

LOGLogUpdateTime

LOGMaxBufferedRec
S

LOGMaxLogFileSize

LOGDirectory

LOGLogLifeTime

LOGCheckDiskTime

Description

Selection of the modules which you want to configure.

Selection of the events which should be logged.
Default: Errors

Number of records, after which all incremental fields will be written.
Default: O (not active)

It is continuously checked, if less than the configured minimal free disk
space is available. The oldest log files are deleted. Minimal free disk space in
MB, before log files are deleted.

Default: 1024 MB

Maximal used disk space for the log in MB.
Default: 1024 MB

Minimal used disk space in MB independent whether LOGMinFreeDiskSpace
is under-run.
Default: 5 MB

Time in ms, after which the received entries are saved.
Default: 2000 ms

The server buffers the contents of all incremental log fields for diverse
applications, in order to be able to write images of them into the log file.
With the start of a log file and after configurable number of log entries a
complete image for all addresses is written into the log file.

Received data are written to the log files. The entry is done via temporary
buffer. It can be configured whether the data should be written immediately
or delayed.

Number of buffered entries if they cannot be saved.

Default: 10240

The server writes the received log data into the log file. If this log file
reaches the configured size, a new file is started.

Maximal size of a single log file in bytes.

Default: 5 MB

Folder in which the log files are written.
Default: $ProgramData%$\COPA-DATA\LOG\

It is continuously cheked, if the lifetime of the log files is exceeded.
The oldest log files are deleted.

Number of seconds to keep the log files.

Default: 14 days

Time in sec, in which the used disk space id checked.
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Default: 60 s

Message level for all | Settings are taken over for all modules.

modules

Default values Restore default settings.

Accept Take over settings for this module.
Cancel Discards changes and closes dialog.
OK Applies changes and closes dialog.

2.1.5 Diagnosis Client

All programs which create log entries are Diagnosis Clients. These log entries are sent to the Diagnosis
Server via TCP/IP. Server computer and port are read - dependent on the used version - from the local
zenon6.ini (on page 13) and contacted. If the connection fails the following procedure is carried out
cyclically:

» If the Diagnosis Server cannot be reach, a reconnect is carried out every 500ms.

» If no connection could be established after half the timeout, the system tries to start the service

zenSysSrv or zenLogSrv.

The settings are configured via entry LOG_CONFIG= insection [SYS REMOTE] (upto 6.51) or
[LOGGING_SYSTEM] (from 7.00).

CONFIGURATION DIAGNOSIS CLIENT
To configure the Diagnosis Client via the dialog:
1. start the Diagnosis Viewer

2. open entry Settings -> Client configuration

(only available if logging is inactive)
3. highlight a Client
4. clickonList of parameters

5. The dialog for configuration is opened
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6. configure the Client
7. Close the dialog by clicking on ok

8. repeat the procedure for other Clients if necessary

CLIENT LIST
'Clients ‘

DiagViewer - CDSBG071.56G.COPADATA.COM: 1163
zenDBSrv - CDSBGO71.58G.COPADATA.COM: 1053
ZENONE3Z - CDSBGO71,5BG.COPADATA,COM: 1166

Refresh | List of parameters I Close J
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Clients

Lists all available Clients.

Refresh

Updates the list of the Clients.

List of parameters

Opens the dialog for configuring the selected Client.

Close

Closes the dialog.

CONFIGURE CLIENT

(ZENONBZ - CDSBGO71.SBG.COPADATA . COM:1166

Modules |

General
et
Proxy
Db
SysSrv
Driver
Log

SAT
Project
User
Stringlist
Connections
Archive
Variables
Types
PFS

", laveal

s v ok |
I~ Errors e I
I~ Warnings

I~ Success ﬂl
I~ Failed Default vaIuesI
I~ Interpal

I~ Message

I~ Debug

I~ Deep Debug

All None I

Message level for all modules |

maximal bufferd records I 256

The available standard modules:
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Modules

Selection of the modules which you want to configure.

The list is made up of standard modules and modules dependent on the
respective client.

) General: General messages

> Net: Network messages

» Proxy: Messages of the zenon Proxy
> Db: Messages of ZenDbSrv

> SysSrv: Messages of ZenSysSrv

» Driver: Messages from a driver

» Log: Messages from logging

> SAT: SICAM 230 specific messages

Message level

Type of information which should be logged.

All

Selects all.

None

Deselects all.

Message level for all
modules

Assigns highlighted message levels to all modules.

Max buffered

Number of records to be buffered if no connection to the server is

records established.

Default: 256
OK Applies all changes and closes dialog.
Cancel Discards all changes and closes the dialog.
Accept Applies all changes. The dialog remains open.

Default values

Enters the default values.




2.1.6 Diagnosis Viewer - Analysis Program

The Diagnosis Viewer is used to display the log data. It connects to the Diagnosis Server in order to display data
online or read back historic log files. Log files contain not only the log data, additional information which is

important for the analysis such as column headings are also saved in them.

To display a log file:

1. select File -> Open

2. the dialog for selecting a log file is opened with focus on the configured default folder

3. select the desired file

4. the log file is displayed

<, Diagnosis Viewer - [LOG050304072743.TXT, LOG050304072743.TXT]

File View Settings Wincows Help - &
A IERAARAIERY
Record version | Record tpe | IP address ProcessID | Log ID | Thread ID | Timestamp | Message level ]
Y Y ¥ i ¥ Y i 2
01 L 192168023 4352 1166.. @036 Q403200 ALL
01 L 192168023 4352 1166.. @036 Q403200 ALL
01 L 921680.23 4352 1166.. @036 Q403200 ALL
01 L 921680.23 4352 1166.. @036 Q403200 ALL
01 L 192168023 4352 1166.. @036 Q403200 ALL
01 L 192168023 4352 1166.. @036 Q403200 ALL
01 L 921680.23 4352 1166.. @036 Q403200 ALL
01 L 921680.23 4352 1166.. @036 Q403200 ALL
01 L 192168023 4352 11686.. 5812 Q403200 ALL
0l L 192168023 4352 1166.. 5812 Q403200 ALL
01 L 192168023 5916 1166.. 1396 Q403200 ALL
01 L 192168023 5916 1166.. 1396 Q403200 ALL
01 L 192168023 5916 1166.. 1396 Q403200 ALL
01 L 9 5916 1166.. 1396 Q403200 ALL
01 L 5916 1166.. 1396 Q403200 ALL ‘v‘
a1 ' conz 11ce 1200 AtAd A Ann
[ lli] 2]
|Lines reacl 369, incorrect lines: 0 [Color option for IP T
Ready I B T S A T

5. Double click an entry to open the detail view
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RECOGNIZING QUEUE OVERFLOW AT DRIVER

If messages of a driver are deleted because of queue overflow, the Diagnosis Client and the Diagnosis
Server set a marker in the new entry when writing a new entry for all activated modules (on page 40)
that older entries were deleted from the queue. The overflow recognitions contained in the opened log
files are counted:

1), Diagnosis Viewer - [LOG100420062607.7XT] | B i
[ Eile Settings View Windows Help - x
$65 0 @47 44664 D00 6 -
Recordversion JP address ProcessD Logld  ThreadID . Timestsmp Message level Module Name of log connection Computer name  Error text
02 1921680.. 328 0 28 29M4010062605415058 AL SYSSRV  ZenSysSev
] 1921680.. 328 0 8 2904201006:2605415058 AL SYSSRV  ZenSysSev SysSev Info InitStr
2 1921680... 1376 1266552 2156 29042010 052605691220 ALL 106 zenDBSw CDSBGOTY
02 1921680.. 1376 11266552 2156  2904201006:2605692221 ALL L0G  zenDESw CDSBGOTY E
] 1921680.. 3228 ) 30 200400062605712233 AL SYSSRV  ZenSysSry SysSev Client:CDS
2 1921680.. 1376 11266552 1168 2904201006:260571823%6 ALL L0G  zenDESw 0386079
[ 1921680... 1376 11266552 3816 29042010062607474289 ALL 0B zenDESw oS8Ty e Init zenDbse
2 1921680.. 328 ] 3B 2904201006410205715 ALL SYSSRV  ZenSysSrv SysSrv Client:COS
8 1921680.. 700 46738584 4760 2904201006:4102086715 ALL LOG  DisgViewer OSBGOS
3 1921680.. 328 0 8 0MN00701197MNS AL SYSSRV  ZenSysSrv SysStv Client:COS
[ 1921680.. 3228 0 088 29042010070421575715 AL SYSSRV ZenSysSrv SysSev Client:COS
8 1921680... 1580 “USA6 4564 2904 2010070420605715 ALL L0G  DisgViewer CDSBGTS
2 1921680.. 328 0 5088 29042010074845179715 ALL SYSSRV  ZenSysSrv SysSev Client:CDS
1921680.. 328 0 840 20042010 07:1829126715  ALL SYSSRV ZenSysSev SysSev Client:COS
(e ) 1921680.. S84 G99480 2002 2904201007181915%715 ALL L0G  DiagViewer COSBGOT
1921680.. 328 0 840 29.04201007:2314090715 AL SYSSRV  ZenSysSrv SysSrv Client:COS
2 1921680.. 328 0 SM4 29042010074239128715 ALL SYSSRV  ZenSysSrv SysSrv Client:COS
8 1921680... 4740 J6H00 1716 20042010074239157715 AL LOG  DisgViewer DS80S
0 1921680.. 328 ] 04 2004010074311428715 AL SYSSRY ZenSysSev SysSev Client:COS
02 1921680.. 28 0 4868 2904201007M44653T715 AL SYSSRV  ZenSysSev SysSev Client:COS
8 1921680... 1036 45165720 3588 29D4200007:M446567715 ALL L0G  Disg¥iewer CDSBGO79
n 1921630, DR n &RAR 2904010 07421340715 AL SVSSRV  ZanSuSrv SweSev Climnt:CNS ~
< v
Zelected: 0 Lines read: 67, incorrect |. Profile test Color option for log connection
Ready Connected to: localhost
4

Parameter Description

Column Record version This column must be part of the column selection. It shows the
version of the data record. Version 8x tags overflows.

Counter 82 8 refers to overflow, 2 refers to the concerned version of the data
record.
Status bar: queue overflows If status bar is active, the number of overflows is displayed there.

Note: Not all entries written in the log file are displayed. If a not displayed log data record is tagged
with an overflow, it will be displayed at the next visualized data record of this client. If several not
displayed entries in a row are tagged with an overflow, the counter in the status bar can deviate from
the number of data records with overflow tags.

Global settings

The entries are in the English language.
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Parameters

File

Open

Open to active
document

Close
Save

Save as

Remote Download

Connect to

Online

Offline

Exit

Description

Commands in menu File.

Opens dialog for selecting a log file saved in TXT format. Each newly opened log
file is displayed in its own window.

Each new log file is added to the active window.

Closes the active window.
Saves the log files of the active window.

Saves the current view of the active window (e.g. filter settings) to a file to be
selected.

Only available, if a connection to a Remote Diagnosis Server exists. Enables the
download of logging files of the Remote Server to the local log folder. A
subdirectory with the name of the PC is created. Only file, which have changed or
which are new, are available.

Opens the dialog for the Connection selection (on page 24).

Activates the online error view.
If online logging is started, all incoming entries are displayed. The same filter
dialog as for reading files can also be set here.

Difference: If no log connection is selected, all incoming log entries will be
displayed, otherwise only the ones from the selected clients.

If the filter of the log connection is modified, all entries not fulfilling the filter
criteria will be lost. (Logging file nevertheless is created and all entries are saved.)
Displayed entries can be saved.

Deactivates the online error view. (Default)

Closes the Diagnosis Viewer.

Connection settings Diagnosis Server connection

The Diagnosis Viewer automatically connects to a selected standard Server at the start. If no standard
server is defined, localhost is used as standard server. The Server configuration can also be done via
zenonb.ini (on page 13) (recommended).
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SELECT DIAGNOSIS SERVER

Click on File -> Connect to... to open the dialog for selecting a Server:

State Diagnosis server name 7

Con;Def localhost

Port Timeout
50730 10

Delete server

Connect to...

As default

ih il

Tools

Zzenon

List Server Lists all configured Servers and displays them:
) Status
> Name
> Port
> Timeout
OK Applies settings and closes dialog.
Cancel

Discards settings and closes the dialog.

New Server

Opens the dialog for configuring a new Server.

Delete Server

Selected Server entry is deleted from the list.

Edit Server

Opens the dialog for configuring the selected Server.

Connect to

Establishes a connection to the selected Server.

As default

Selected server becomes the standard server.
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CREATE AND EDIT DIAGNOSIS SERVER

Click on New server or Edit Server in dialog Diagnosis Server connection to open the dialog for
configuring the Server:

o e = |
Server name: m
' '

Port:
50730

Timeout:

Server name Name of the PC to which to connect.

The following must run on the PC:
up to version 6.51: zenSysSrv

from version 7.00: zenLogSrv

Port Port of the service on the target computer:
up toversion6.51: 1101

from version 7.00 on: 50780

Timeout Time in seconds to wait for a response from the Sysservice.
Default: 10 s
OK Applies settings and closes dialog.

Cancel Discards settings and closes the dialog.




Column settings

Tools

Zzenon

A number of pre-defined columns can be selected in the menu under Settings -> Column settings. These
columns and their entries are automatically displayed on opening a new file. Also the sorting and the
column width of the selection are regarded. On opening the column width has to be set to Autosize.

M

Column selection
available:

ID ¥  Column name
i Record version
i Record type
2 Thread name
5 Assert condition
9 Project GUID
10 Project path
i1 Sent Data
12 Received data
23 Metwork port no.
24 Server name
25 Standby name
26 Client name
27 Server IP
28 Standby IP
29 Client IP
. Rinzru buffar

m

bin] Column name

IP address

Process ID

Log ID

Thread ID

i |Messagelevel |
i Timestamp

Module

Mame of source files

m

Source line
Computer name
Function name
Project name

no. serial interface

Raudrata
I ] *

ESpEN

bt;m‘-.la\-bw_'

rom

[_ok ] [[bbrechen |

available available columns

selected Columns which are displayed

> adds columns selected at "available" to "selected"

>> adds all available columns at "available" to "selected"

< removes selected columns from "selected"

<< removes all available columns from "selected"

~ sorts selected entries one level higher (multi-select is possible)
v sorts selected entries one level lower (multi-select is possible)
OK Applies settings and closes dialog.

Cancel Discards settings and closes the dialog.

Columns can also be configured via the context menu:
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Add all columns with
entry

Adds all columns which contain entries.

Remove Column

Hides the selected column.

Remove all empty
columns

Hides all columns which do not contain entries.

Column width
automatic

The width of the selected column is automatically adjusted to the longest
entry

All columns widths
automatic

The width of all columns is automatically adjusted to the longest entry

2.1.7  Possibilities of Filtering

To define filters open the corresponding filter dialog via the corresponding symbol or the tab of the

filter.

SYMBOL BAR FILTER

To use the symbol bar, you must activate it in menu view via menu item Icon bar.

AR R
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1 Change pre-filter Opens dialog with five tabs for defining filters.
settings

2 Change pre-filter for Opens tab IP address - Process No - Log ID (on page
IP-ProcessID-LogID 39) .

3 Change pre-filter for Opens tab Modules (on page 40).
modules

4 Change pre-filter for Opens tab Additional columns (on page 41).
additional columns

5 Change pre-filter for Opens tab Time interval (on page 42).
time interval

6 Change pre-filter for Opens tab Colors (on page 43).
coloring

FILTER DIALOG

o T ey |

available:

IP address - Process No-Log 1D | Modules | Additional columns [ Time interval | Colors |

selected:

Log connection ¥

Log connection ¥

Intern_WELT _Treiber fiir interne Vari...
MATHDR32_WELT _Treiber fiir Mathe...
SIMUL32_WELT_SIMUL_WIZ
SIMUL32_WIZARD_SIMUL_WIZ
SYSDRY_WELT _Treiber fur System-V...

intern
mathdr32

simul32
sysdry
zenDBSrv
zenLogSrv
zenone32
zenrt32

[ ok | [ abbrechen
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IP-ProcessID-LogID Opens tab IP address - Process No - Log ID (on page 39) for
configuring the connection which should be logged.

Modules Opens tab Modules (on page 40) for the modules which should be
logged.
Additional columns Opens tab Additional columns (on page 41) for selecting additional

columns which should be displayed.

Time interval Opens tab Time interval (on page 42) for defining time filter.
Colors Opens tab Colors (on page 43) for selecting the color-coding of
information.

IP address - Process No - Log ID

Configuration of the connections and processes which should be displayed.

o T ey |

IP address - Process No-Log 1D | Modules | Additional columns [ Time interval | Colors |

available: selected:

Log connection ¥ Log connection ¥

Intern_WELT _Treiber fiir interne Vari...
MATHDR32_WELT _Treiber fiir Mathe...
SIMUL32_WELT_SIMUL_WIZ
SIMUL32_WIZARD_SIMUL_WIZ
SYSDRY_WELT _Treiber fur System-V...
intern

mathdr32

simul32

sysdry

zenDBSrv

zenLogSrv

zenone32

zenrt32

M A
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available

List of available connections.

selected

List of selected connections.

Cursor keys

Add selected (>) or all (>>) connections to list selected or removes them from
the list (< or <<).

OK Applies all changes from all tabs and closes dialog.
Cancel Discards all changes from all tabs and closes dialog.
Modules

Selection of the modules which should be displayed.

| 1P address - Process No-Log ID | Modules | additional columns | Time interval | Colors |

Module filter active

available: selected:
Modules + Modules + e
GEMERAL

MNET

M A
B M
8§

GetSetSrvParam
SAT

Project

User

Stringlist
Connections
Historian
Variables

Niats hunae
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Module filter active Active: Itisfiltered on modules.

With this only log data records are displayed which are assigned
to a selected module.

available Available modules.
selected Selected modules.
Cursor keys Add selected (>) or all (>>) connections to list selected or removes

them from the list (< or <<).

OK Applies all changes from all tabs and closes dialog.

Cancel Discards all changes from all tabs and closes dialog.

Additional columns

Selection of the columns which should be displayed additionally.

o T ey |

| IP address - Process No-Log ID I Moddes| Additional colurnns |r.||e interval I Cokws|

available: selected:

L3

Column name ¥ Column name ¥

Archive

Arv short
Arv var idx
D

Type id
Type name
Parentid
Parent name

M A

Driver id
Driver name
Driver descr.
Action
Command
Picture
ILock state

Pirdirmizatine Marme

ESpEN




Tools
zenon

available

List of the available columns. All field definitions existing in the file are displayed.

selected

List of the selected columns.

Cursor keys

Add selected (>) or all (>>) connections to list selected or removes them from
the list (< or <<).

OK

Applies all changes from all tabs and closes dialog.

Cancel

Discards all changes from all tabs and closes dialog.

Time interval

Configuration of the time filter for displaying the entries.

| 1P address - Process No-Log ID | Modules | Additional columns | Time interval | Colors |

Start time:

[E.03.2011 2 wisss =i
End time:
[ R =]
18.03.2011 = 12002 =
Reset time interval
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Start time: Selection of the date and point in time from which entries should be
displayed.

Default: Current date

End time: Selection of the date and point in time up to which entries should be
displayed.

Default: Current date

Reset time interval Sets filter back to default value.

OK Applies all changes from all tabs and closes dialog.

Cancel Discards all changes from all tabs and closes dialog.
Colors

Selection of the color-coding of the information.

[ 1P address - Process No- Log ID | Modles | Additional columns | Time interval | Colors |

Color for:

() IP address

() Modules

() Log connection

() no colors

[ ok | [ abbrechen




Parameters Description

Colors for: Selection of the color

IP address Active: Different IP addresses are colored differently.

Modules Active: Different modules are colored differently.

Log connection Active: Different names of the log connection are colored differently.
no colors Active: Entries are not colored.

OK Applies all changes from all tabs and closes dialog.

Cancel Discards all changes from all tabs and closes dialog.

2.1.8 Reading the log files
One or more log files can be opened in an analysis at the same time.
A pre-filter has to be set to limit the display.

This is possible with five property pages. This filter can be modifies later on. If the filter is set, only the
entries fulfilling these filter criteria are displayed. The entries are listed chronologically.

Another filter possibility is available with the filter columns. Filter criteria can be entered for each
column below the column header. The fields support regular expressions, so that also complex filter
criteria can be defined.

The list can be sorted ascending or descending by clicking the column headers.
Displayed entries can be saved.

Fields in the log file:
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IP address/Process These fields identify the clients and allow the message to be assigned.
ID/Log ID

Name of log Shows the connection name.

connection

Thread ID ID of the thread, from which the message was entered.
Timestamp Time of the message in UTC.

Message Level Shows the name of the message level, which entered the message.
Modules Name of the module, which entered the message.

Optional fields with fix ID.
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1 logid_logname Name of logging connection
2 logid_threadname Thread name

3 logid_sourcefile Source file name

4 logid_sourceline Source line

5 logid_assertcond Assert condition

6 logid_compname Computer name

7 logid funcname Function name

8 logid_prjname Project name

9 logid prjguid Project GUID

A logid_prjpath Project path

B logid_tx Sent data

C logid rx Received data

D logid_serialport Number of the serial interface
E logid _baud Baud rate

E logid_dtr Dtr setting

10 | logid rts Rts setting

11 | logid bytesize Serial character length
12 logid_parity Parity

13 | logid_stopbit Number of stop bits
14 logid _ctsflow CTS

15 logid_dsrflow Dsr

16 | logid dsrsens Dsr sensitivity

17 | logid_port Network port number
18 | logid srvname Server name

19 | logid_sbname Standby name

1A | logid_cliname Client name




1B

1C

1D

1E

1F

20

21

22

23

24

25

26

27

28

29

2A

2B

2C

2D

2E

2F

30

31

32

33

34

35

logid_srvIP
logid_sbIP

logid cliIP
logid_bindump
logid_ptr
logid_classname
logid_errcode
logid _dllinstance
logid_dllname
logid_errparl
logid_errpar2
logid_trace
logid_errortxt
logid_errorfile
logid_succeedcond
logid_succeedvalue
logid net
logid_db

logid ofs

logid bit
logid_area

logid dir
logid_txt

logid mainvers
logid minorvers
logid buildvers

logid_sp

Server IP address
Standby IP address
Client IP address

Binary buffer

Pointer

Class name

Error code

DLL instance handle

DLL name

Driver error parameter 1
Driver error parameter 2
Trace message

Error text

Error file name
Condition for success
Value when successful
Net address

Data block

Offset

Bit number

Area in PLC

Shows the direction of the communication in a string.

General text

Main version number
Minor version number
Build number

Service pack
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36 | logid hotfix Hotfix number

37 | logid clisrc Client, which sent the command

38 | logid clidst Client, which is the target for the command
39 | logid pvid Datapoint number (channel number)

3A | logid pvname Datapoint name

3B | logid pvvalue Value of datapoint

3C | logid pvstatus Status of datapoint

3D | logid pvtime Time stamp of datapoint in sec

3 | logid duration Time duration in ms

3F | logid _ecnt Number, counter

2.1.9  Structure of the log file

Log files are ANSI text files. The single fields are separated by tabs. The final character is CR+LF. So, the
Notepad can be opened to display the files.

Log files contain information sequentially, not chronologically sorted.

Message levels

Eight groups exist for the subdivision of log messages. They are bit coded and therefore can be
combined.
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1 Error messages

2 Warnings
4 Success message
8 TRACE

16 ASSERT
32 Log messages
64 Debug

128 Extended debug

Search function

With view/Find the current window can be searched. All hits are marked.

Profile

Column settings can be saved as profiles.

To save profiles:

1. enter a name into the filed in the tool bar

2. click on the disk symbol on the right-hand side
To load profiles:

1. select a saved profile from the combo box

2. click on the second symbol on the right-hand side with the disk

The profiles are saved a *.lvs files.
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2.1.10 Error handling and messages

ERROR
Error Possible causes
The port cannot be opened. »  Another application uses the port.
Check via "netstat".
> The ports for entries
[SYS_REMOTE] CONFIG and
[LOGGING_SYSTEM] CONFIG
are identical. zenLogSrv and zenSysSrv then try to open the
same port.
Diagnosis Clients do not start the » zenAdminSrv was terminated. Without it the service cannot be
zenLogSrv started.
» zenLogSrv is not registered as a service at the PC. In this case enter
the following in the command line: zenLogSrv.exe —Service
»  Diagnosis Clients are not of version 7.00 SPO or higher. The
zenLogSrv is only supported from this version on.
» Under Windows CE: The individual components (Runtime, SysSrvCE,
LogSrvCE) are located in different folders. They must be located in the
same folder. Otherwise the components do not find one another.
Under CE many processes are created > One of the two entries in zenon6.ini
by SysSrvCE.exe or LogSrvCE.exe. [SYS_REMOTE] INIT or
[LOGGING_SYSTEM] INIT
has the value 2.
As a result the application only displays the user interface and does
not open the Listening port. Each Diagnosis Client then tries to start
the process as it cannot connect to the Diagnosis Server.
Several processes crash. »  The versions do not match. Diagnosis Clients, Diagnosis Server and

(Unhandled Exceptions of the
Diagnosis Server at receiving log
messages or configuration commands
or of the Diagnosis Client and
Diagnosis Viewer during booting or
during receiving the configuration)

Diagnosis Viewer must either all have version 7.00 SPO or higher or all

version 6.51 SPO or earlier (see Compatibility (on page 8)).
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LOG ENTRIES

Entry
SysSrv received not supported

network message!

LogSrv received not supported
network message!

Could not open listening
port. Server will be stopped.

Description

zenSysSrv received a network telegram which is not supported.
Example: Log entries.

zenLogSrv received a network telegram which is not supported.
Example: Remote Transport commands

The zenLogSrv or the zenSysSrv could not open its Listening
port. The error message is logged as follows:

> zenlLogSrv and zenSysSrv at PC:
Entry in the Windows event display.

»  zenSysSrv under CE:
Message box for the user and log entry to the Diagnosis Server.

»  zenlLogSrv under CE:

Message box for the user.

The following log entries are assigned to different systems. The first part of the messages states whether
service or Client are effected:

4

4

4

4

SysSrv: zenSysSrv
SysCli: Client to the zenSysSrv
LogSrv: zenLogSrv

LogCli: Diagnosis Client
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Entry Description

[SysSrv/LogSrv/SysCli/LogCli]l | A network connection has been initialized with the displayed
Info InitString [String] configuration string. Server opens ports and Clients connect to the

Server.

[SysSrv/LogSrv/SysCli/LogCli] | An exception occurred during a network operation. The details are
WINSOCK ERROR also displayed.

[SysSrv/LogSrv] Accept An incoming connection from a Client could not be accepted.

Failed!

[SysSrv/LogSrv/SysCli/ Not all data which should be sent could be sent. The number of

LogCli] Write Faild the sent bytes and the number of the bytes which should be sent
is displayed.

[SysSrv/LogSrv] Client The Client log off from the Server.

[String] in List Delete!

[SysSrv/LogSrv] Client The Client log on to the Server.

[String] in List Insert

2.2 Keyblock Runtime Start

Keyblock Runtime Start is a program with which both the zenon Runtime is started and the Windows
system keys are locked. Shortcuts such as Windows key or Ctr1+Alt+Del no longer have an effect.

This functionality is necessary when the zenon Runtime should run as "Shell". User can no longer access
the operating system but only work on the zenon user interface.

The precondition for this is that the project properties are set Runtime titletoNo title

(full screen).Then zenon runs in full screen mode and the Runtime cannot be minimized.

3 License information

Part of the standard license of the Editor and Runtime.

2.2.1 Use

To use Keyblock Runtime Start:

52



in the Windows start folder under COPA-DATA open the zenon tools
select Keyblock Runtime Start
the program starts and automatically starts the Runtime

The program locks allaccess to the operating system:
e locked shortcuts:

Ctrl+Alt+Del

Ctrl+Esc

Alt+Tab

Alt+Esc

Alt+F4

Windows key

When locking the system keys, the normal operation of the scroll bars with the mouse in
the Runtime is also blocked. You can work around the blocking with the help of the
context menu.

¢ Hiding the Control Panel in the start menu
e Locking the tool bar for operation

e Prevents
Changing passwords
Closing Windows

Log out

Locking the computer

User change

e Hiding all element in the task manager
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Y Info

If Keyblock Runtime Start is started using the auto start mechanism of the

operating system:

> take care that the auto start folder is user-specific: If an other user is logged in, the program is not

executed.

> processing the auto start programs can be prevented by pressing Shi ft during the booting of the

operating system.

This locking cannot be bypassed during Runtime. When the Runtime is closed normally, the system
restrictions are canceled. If the Runtime should be operable without these limitations, the Runtime

must be started instead of Keyblock Runtime Start.

A Attention

Take care that you engineer a possibility to close the Runtime in your project. There is no

possibility to end the Runtime regularly.
» if it can only be ended by turning off the computer
> all system keys are still locked after a restart

To make systems keys available after an irregular ending (e.g. black out):
> start the Runtime again with the help of Keyblock Runtime Start

» end the Runtime regularly via a close button

2.2.2 Protect Runtime files

The access to the Runtime files can be strongly restricted and therefore well protected. At this only a
single Windows user has read and write rights for the Runtime folder. All other Windows user do not
have any rights in the Runtime folder including read rights. Operators in the Runtime log on as zenon

user.

In order to limit access to the file system:

1. Only create a single Windows user (for instance: zenon_aDMIN) who is authorized to start zenon

as well as to read and write in the zenon Runtime folder.
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2. Disable access to the zenon Runtime folder for all other Windows users — including read

authorizations!
3. Disable any remote access to the user zenon_ADMIN.
4. Block any software for remote maintenance or remote access such as zenon Remote Desktop.

5. Make sure that zenon can only be started if this user (zenon_apMIN) is logged in.
Since other Windows users do not have read authorization Runtime will only start in the context

of this user (zenon_aADMIN).

6. Make sure that zenon runs as shell:
a) For this purpose, create a zenon autostart with Keyblock Runtime Start (ONn page 52)
b) activate the property Lock system keys inthe group Runtime settings of
project properties
c) start zenon in full-screen mode: Set property Runtime titletoNo title
d) also bear multi-screen systems in mind in the configuration
e) disable Explorer start

f) do not offer file selection dialogues
(in this case no functions may be projected which require the user to select files in
Runtime)

The access to the zenon file system is then protected.

2.3 Online updating of the zenon Help:

The help PDFs and online help are updated online.
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For this, you can find, in the zenon program folder, in the Documentation 7.10 subfolder, the
Documentation Download Tool program. This works in a similar manner to the Windows check for
updates control function.

This tool can download and install the latest documentation. It updates online help (chm fies)as well as offline
help (pdf files) Please select the version and the language you want to update.

Version: Language:

|Version 6.51 SPO | |cerman -

Information:

C:\Program Files (x86)\COPA-DATA'zenon 6.51 SPOHELP\GERMANPDF 'Handbuch'Aenderungshistorie pdf
C:Program Files (x86)\COPA-DATA'zenon 6.51 SPOHELP\GERMAN'PDF 'Handbuch'Masseinheiten pdf
C:Program Files (x86)\COPA-DATA'zenon 6.51 SPOHELP\GERMAN'PDF ' Handbuch'Menues pdf
C:\Program Files (x86)\COPA-DATA'zenon 6.51 SPOHELP\GERMANPDF \Treiber'3964R32 pdf

C:\Program Files (x86)\COPA-DATA'zenon 6.51 SPOHELP\GERMANPDF\Treiber'35S_32 pdf

C:Program Files (x86)\COPA-DATA'zenon 6.51 SPOHELP\GERMAN'PDF Treiber'\3S_Arti pdf

C:Program Files (x86)\COPA-DATA'zenon 6.51 SPOHELP\GERMAN'PDF \Treiber'3S_Arti NG pdf
C:Program Files (x86) . COPA-DATA'zenon 6.51 SPO'HELP\GERMAN'PDF ' Tutorials'FirstSteps. pdf
C:\Program Files (x86)\COPA-DATA zenon 6.51 SPOHELP\GERMAN PDF '\ Tutorials' L angnage Switching pdf
C:\Program Files (x86)\COPA-DATA \zenon 6.51 SPOHELP\GERMAN PDF '\ Tutorials' Network pdf

Start download




Tools

Zzenon

Version:

Selects the version (available from zenon 6.51).

Language:

Name of the language of the desired download.
The following languages are currently available:

> German
>  English
»  French
> Italian

Information:

Displays the available files after the version and language
have been selected.

Start download

Starts the recipe process.

After selecting the version and the language, the available files are displayed in the main window of the

Download Tools.

A click on the start download button updates your help.

The following content is available, as a PDF and embedded help respectively:

» Manual
» Driver
» Tutorials

» Glossary




Y Info

Admin rights are necessary to execute the Documentation Download Tool program.

To define the start with administrator rights:

4

Right-click on the Documentation Download Tool program icon

In the Properties menu, select:

Change to the Compatibility tab in the following window

Highlight the Run program as administrator optionand

confirm the setting by clicking on OK

2.4 Project Translation Interface

The tool is an aid for the translation of zenon projects:

» Translatable texts can be broken down according to their use, for example screens, units and

other texts.

» The following screen is displayed for the translation.

» The positioning of the text in the screen can be accentuated graphically (using Expose).
» These are also displayed when using a text in several screens.

» The individual screen display can be selected from several screens.

» Text lengths are shown graphically (using highlighting).

» This can be visualized if the length of text is exceeded.

» In addition, font lists can be used for the graphic display.

3 License information

Part of the standard license of the Editor and Runtime.
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2.4.1  Starting the translation tool

To start Project Translation Interface:

1. Inthe Windows Start Menu, navigate to All Programs -> COPA-DATA

2. Click on Project Translation Interface

3. Project Translation Interface starts

No Longuage Files looded.

Note: The tool is only available in English

2.4.2  Technical background

The Project Translation Interface and the zenon Language Translation Wizard work together closely.

THE WIZARD
» searches through COPA-DATA projects, for translated text
» packs these into an XML file

» creates screenshots of the screens with translatable texts




Tools
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» compresses the XML file together with the screenshots, the files for the language translation and

the font lists of the projects into a ZIP file.

» After translation in the Project Translation Interface, imports the translated texts back to zenon.

THE INTERFACE
» opens the ZIP file created by the Wizard
» supports the translator with file structuring, word length check and and graphical display

» exports the finished translation into a ZIP file

2.4.3  Overview of graphical user interface

_Ig""'l Style @

3 4 on | Hhnd L uTORIAL POUESH.TX. < ¥ kxpoze | tamoae -
" a Copy | %5, Replace | [/ Highlighting Positive =
e AL Language_partugue - |
Edit Cheek Fighlighting |
— s
Fitter BE | Keyword N ZENONSTR.TXT TUTORIAL-POLISH.T) = | Seresnshat View B ¥ Sereens Cverview %
o TUTORIAL INTERNA' | (o |7 Filtestest (7] Fitertext 2
O Samens Harmfurition “Mlembunkion “Alsrmunktion e e—,
B &'.’:'m Alletoschen Allegschen Al leschen ~
Al quittieren Alle quittieren Alle guittieren
Arzahl Anzabi Anzahl
beckup bild backup kild backup bild
Beizpiel ALARMmeldefzte Beispiel ALARMmeldaliste Beispiel AL
Beispiel CEL Beispéel CEL Beispiel CEL
Drucken Drucken Dracken
Export Esport Export
Filker Fiter Filter
Filker . Fiter .. Filtes ..
Filber... Fikter... Filter...
Filterprofile Filterprcile Fiterprofie —
Fiallstand Fillstarsd pemom
Funition ausdGhren Furition ausfihen Funktion ausfaheen
Gallonen Gallanen Gallonen
Gesamt Gesamt Gesamt
Hilfe sufrufen Hife aufrufen Hilf2 aufnfen
Import Impest Import
Klenaanlage Kiimaslage
Eommentar Kamarardar Kemeantas
Liter Liter Liter
Leschen Loschen Laschen
Main Mein Msin
i i | | = ]
Resdy.

Filter Use of text in the grouped display.

Note: The branch contains only groups that also
actually contain text.

Main window List of the text to be translated.

Each column represents a language file in zenon.




Screenshot View Screenshot of the screen selected in the Screens

Overview.

Screens Overview List with screenshots of the screens in which the
text from the main window is used.

Note: Graphics used are not displayed
independently of language.

2.4.4 Main menu

Button Description

New Creates a new, empty translation project.
The active project is closed and saved.
Open. .. Opens translation project.

Import from Zip... Opens the zenon project data exported by the Language
Translation Wizard.

Save Saves the current translation project.
Export as Zip... Exports the translation project as a ZIP file.

This can be re-imported into zenon with the help of the
Language Translation Wizard.

Recent Documents List of the projects last worked on.
Clicking on the name opens the translation project.

X Exit Ends Project Translation Interface.

General features

The Project Translation Interface offers the following options:

» All windows (except the text list) can be dragged from the main window of the tool (for example

to a second monitor).
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2.4.5

When selecting a group in the node, all texts used - in the selected group - are displayed in the
main window. The top group (with the name of the zenon project) contains all texts used in the

project.

When selecting a text in the text list, screenshots of the screens in which the text is used are

displayed in the screenshot View and Screens Overview displays.

When selecting a screen in the screens overview window, a screenshot of this is shown in the

Screenshot View wWindow.

Expose and Highlighting are displayed according to the settings in the Highlighting

menu bar.
The colors can be set via the drop-down lists in the Highlighting menu bar.

The text file and the font list for checking the text length (Highlighting), can be setin the

Check menu bar.

Menu bar

) - ]
Q Home

& Cut 33 Find &), TUTORIAL-POLISH.TX - V| Expose Expose -
53 Copy 2. Replace Highlighting | Positive -
Paste H -
T Select Al g Language_portugue Negative -
Clipboard Edit Check Highlighting
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EDIT
Button Description
Find Carries out a search in the column highlighted in the text list.
Note: Click in a column to highlight it. This is also marked with a binocular symbol.
Replace Carries out a search and replace in the column highlighted in the text list.

Note: It is not possible to replace text in the key word column.

CHECK

Selection of the language file and font list for display in the Sscreenshot View and Screens Overview
windows.

HIGHLIGHTING

Defines how the elements are displayed in the screenshot.

» Expose:

o Emphasizes the text in the screenshot view window if activated.
» Highlighting:

¢ Changes the display in the screenshot view Window, depending on the text length.
Positive = Text fits into the element Negative = Text is too long and can be
properly displayed in the configured element.

Button Description

Expose checkbox Activates or deactivates the Expose function for the
Screenshot View preview window.

Highlighting checkbox Activates or deactivates the Highlighting function for the
Screenshot View preview window.

Expose drop-down list Dialog to select the colors for the Expose function.
Positiwve drop-down list Dialog to select the color for positive.
Negative drop-down list Dialog to select the color for negative.

Y Info

The elements from the Clipboard menu bar are not used.
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2.5 Startup Tool

The Startup Tool makes it possible:

» to start Editor and Runtime with certain parameters

» to run different zenon versions on one computer in parallel

(already installed zenon versions are automatically created in the Startup Tool)
» to administrate different SQL instances for the same zenon version
» to administrate the settings for different versions

» to define the language of the Editor and the Runtime before the start

3 License information

Part of the standard license of the Editor and Runtime.

& Attention

The Startup Tool does not start when the service zenAdminSrv is not running. If it is
not active, you can start it manually in the Windows Control Panel under

Administrative tools/Services.

2.5.1  Start dialog

You administrate the currently installed zenon versions in the start dialog. From version 7.10, you have
the possibility to choose whether to start Editor and Runtime as a 32-bit application or as a 64-bit
application.
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If only a 32-bit version of zenon 7.10 was specified or an older version was detected, only one button is
shown for the Editor and Runtime respectively:

r Startup Tool ]
Application Item Help
MName Version BER
(). zenon 7.10 7.108p0| At
L zenon 7.0 7.005P 0 Editor
Runtime
Runtime
Register
O’ Register
Help Tools
Al X
Move selection
JiL 4
] 1 3 V

If both versions are specified, separate buttons for 32-bit and for 64-bit are displayed.

F ™
Startup Tool e e
Application Item Help
MName Version BER
[T 2enon 7.10 7,10 5P o il
# zenon 7.0 7.005P0 7
)
Move selection
“ 1 3
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Button

Editor

Runtime

Register
Help

Tools

Function

Starts the Editor of the selected zenon version

Two separate buttons are available for 64-bit versions. The button for 64-bit
contains a corresponding indication in the bottom left corner.

Starts the Runtime of the selected zenon version

Two separate buttons are available for 64-bit versions. The button for 64-bit
contains a corresponding indication in the bottom left corner.

Registers all services of the selected zenon version
Opens zenon help.
Opens a dialog for starting additional applications of the selected zenon version

If the tools for a valid 64-bit version are opened, then the tools are
displayed in two lists for 32-bit tools and 64-bit tools.

PROCESSES DURING STARTING

When starting the Editor or the Runtime, data from the start settings are written to the zenon6.ini
file. Existing settings in the INI file are overwritten.

Since version 5 the network communication is handled with two services (zenNetSrv.exe and

zenSysSrv.exe). Both files must exist in the zenon folder. As these services are version dependent,
they must be registered for the appropriate version.

A Attention

After conversion of a project into a later zenon version, this can no longer be edited with

the previous version and will no longer run on it. However, the backup version created

during the conversion can still be used in the original editor.

For network projects, the same zenon Editor versions must be started on the server and

clients.
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Application
Options Opens the dialog for configuring the settings.
Exit Closes the Startup Tool.

OPTIONS

Entry options in menu application opens the settings for the Startup Tool.

» General (on page 67): general settings

» Encrypt network communication (on page 68): Configuration of the strong encryption of the

network communication

General

General settings:

Application settings

General

Start Startup Tool minimized

Remember last registered version
Register all OC¥ files of selected version

Set language For Editor or Runtime:

English -

l Ok I [ Cancel




Parameter

Start Startup
Tool mimimized

Remember last
registered
version

Register all OCX
files of
selected version

Set Language for
Editor or
Runtime

Network configuration

active

Starts the Startup Tool minimized.
You can reach the tool with the help
of its icon in the task bar.

The context menu offers all possible
actions from the Start dialog (on page
64) for the active zenon.

Sets the chosen version as standard
and selects it automatically at the
next start. Then the version is not
registered again (default).

registers all OCX files (ActiveX
controls) which exist in the program
folder.

This option makes sure that there are
always appropriate ActiveX controls
for each version (default).

Attention: It has no influence on the
registration of ActiveX controls and
COM servers which are listed in the
individual settings (on page 80) of the
respective version.

Starts Editor or Runtime with the
language selected in the selection list.

Makes sure that zenon always uses
the defined language when started
from the Startup Tool. This does not
influence the direct start of
zenon.exe.

The following applies for zenon from version 7 onwards:

» youcan use IPv6

inactive

Opens the tool on the desktop (default).

Offers the first version in the list when
starting the Startup Tool. When the
Editor or the Runtime are started, the
respective version is always registered
again.

registers only the pre-set components.

This option accelerates the registration
process and is appropriate for all
projects which do not use ActiveX.

Starts Editor or Runtime with the
language defined in zenon6.ini. There
the set language is the language which
has lastly been used in zenon or defined
there under Options -> Settings ->
Editor and Runtime selected language
(default).
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» you can encrypt the transfer in the network.
This dialog configures:

» Time-outs

» the use of TCP/IP via IPv4 or IPv6

» the serious encryption of the network communication at the local computer

Application settings @

- Metwork configuration

General settings

Metwork communication timeout

30 s

Metwork module timeout
30 s

Use dient time synchronisation

[T Use 1Pv6 for all TCR/IP connections (v7.0 and higher)
ATTENTION: If you change this setting you can no longer
use versions older than 7.0!

Encrypt network communication {v7.0 and higher)

|:| Encrypt network communication

Password

Confirm password

OK. ] [ Abbrechen
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Parameter

General settings

Network communication time-
out

Network module time-out

Time synchronisation with
server project

Use IPv6 for all TCP/IP
connections

Description

General settings.

Changes of these settings are written to the registry in files
zenon6.ini or zenon. ini and overwrite possibly varying
manual configuration.

Changed settings must be carried out for all Runtime
computers or all connected stations. At changes of the IPv6
settings, the computer must be restarted.

Changes are carried out after leaving the dialog only
after the confirmation of a warning message with click
on button Yes.

Time-out for network communication in seconds.
Default=30

Equalsentry NET TIMEOUT MSEC=in file zenon6.ini.

Time-out for module communication in seconds.
Default=30

Equals entry NET NETMODULE TIMEOUT MSEC=in

file zenon6.ini.
Active: Timeis compared with a server project (default).

Inactive: Timeis not compared (for circular redundancy,
for example)

Equals entry TIMESYNCH in file zenon6. ini.
Active: All TCP connections are only established via IPv6.

Inactiwve: All TCP connections are only established via
IPv4,

Dual operation is not possible.
Equals entry USEIPV6=in file zenon6. ini.

Note: If this option is changed, the computer must be
rebooted. The change must also be carried out on all
connected stations.

The following components are not affected by the setting:

»  Driver communication with the PLCs
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Encrypt network communication

Encrypt network
communication

Password

Verify password

A Attention

> Protocol communication in the Process Gateway plug-ins
> Workbench and Runtime communication in zenon Logic

Attention: Only works with version 7 onwards. No versions
prior to version 7 can be started if this is active.

Settings for serious encryption in the network

Active: Communication in the network is encrypted.

Enter password.

For the criteria, see the "Network encryption password"

section in the Strong encryption of network communication
chapter.

The displayed length is always set at 20 characters, in order to

hide the actual length.

The password defined here is stored encrypted in the

zenon6.ini.

Enter the password for verification again.

If entries were changed manually in the local zenoné6. ini, they are overwritten as
soon as the confirmation message is answered with "ves" at the registration.

MESSAGES

For explanations about system messages and error messages see chapter Message at registration (on

page 82).

Y Info

You can find notes on error messages from strong encryption in:

Network handbook -> Strong encryption of network communication chapter -> Error

messages section.

71



Item
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The menu Item has the following entries:

Zzenon

New Creates a new entry in the list and opens dialog Properties (on page 72).
Delete Deletes the selected entry after confirming a confirmation message.
Properties Opens dialog Properties (on page 72) for the selected entry.

Help

In menu help the following entries exist:

» Help: opens the online help

» Info about: shows version information.

2.5.2 Properties

In dialog Properties the parameters for each entry are defined:

General General settings

Database Settings for the database connection

Extras Settings for registering ActiveX controls (OCX) and COM servers (DLL) and for starting
additional programs or batch files.




General

In this part, details about the zenon versions are entered. The path to the 32-bit version of zenon is
absolutely necessary. If the Startup Tool detects a 64-bit version, the path to the 64-bit version is also
unlocked for input.

r ~
Properties... @
General | Datal | Extras

General

MName

lzenon 7. 10|
Version

7.10 5P 0 Build 4582
Program path {32-bit)

C:'Program Files (x86)\COPA-DATA\zenon 7. 10 SPO E]
Program path (64-bit)

C:\Program Files\COPA-DATA\zenon 7.10 5P0 E]

Editor
Workspace
C:\Wsers\Public\Documentszenon_Projects\7100\710.w E]
Editor-Project
710 -

"] read back the INI settings

Runtime
RT-Project
710 -

RT-Path
C:Wsers\Public\Documentszenon_Projects 7101710 E]

[ Ok ][ Cancel ]

The following properties are available for a selected entry:



GENERAL

Tools

Zzenon

Name Distinct name as it should be displayed in the list. This entry is absolutely
essential.
Version Startup Tool automatically enters the version number of zenon. For this you

must first select the program path under Path.

Program path (32-
bit)

Program path in which the executable 32-bit version of the zenon file
(Zenrt32.exe) is located.

If a 64-bit version of zenon is detected here, the Program path (64-
bit) property is also unlocked for input.

Program path (64-
bit)

Program path in which the executable 64-bit version of the zenon file
(Zenrt32.exe) is located.

Input only possible if the path to the 32-bit version was stated and a 64-bit
version was detected by zenon.

As soon as both paths have been entered correctly, the buttons for starting
Editor and Runtime are divided into two buttons, one for 32-bit and one for
64-bit.

EDITOR

Workspace

The desired workspace when the Editor is started. As soon as this is entered
all projects which are in this workspace are displayed automatically in the
drop-down list under Editor project.

Editor-Project

Select the project which should be active after the Editor started.

Read back the INI
settings

Active: All changed settings are read automatically after the Editor is
closed. These settings are used for the next start of the Editor. (This affects
Workspace, Editor-Project, RT-Project and RT-Path).

Inactive: The settings of this dialog are always used when the Editor is
started. Changes made while working with the Editor are discarded.

RUNTIME

RT-Project

Project that is set as the start project for Runtime.




RT-Path Path of the project. If the Runtime project is part of the workspace, the path

is entered automatically.

¥ Info

UNKNOWN PARAMETERS?

If the settings for the workspace are unknown, use the following approach.

4.

Enter Name, Path and Workspace
Leave Editor-Project, RT-Project and RT-Path empty
Activate Read back the INI settings

Leave dialog by clicking ok.

After the Editor has been started and closed once, the start settings are automatically
taken from the INI file.

Database

Define the database properties. It is possible to use different SQL instances for the different entries

(zen

on versions).

A Attention

As of version 6.51 the SQL instance can be defined and the password is saved in an

encrypted form. New entries have a higher priority than existing entries.

Compatibility: If nothing is changed, the existing entries remain valid. If you change an
entry for version 6.51 or higher, the new entries are valid. Older versions must be
maintained separately. You can find the settings for version previous to 6.51 in chapter

Database previous version 6.51 (on page 78).

Display dialog: The display of the dialog is automatically adopted to the selected
version (previous 6.51 (on page 78), as of 6.51).
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Properties...

General | Database |Extras

[ Readfiomzenveini | | Clearallfieds |

SQL Instance

localhost\ZENON_2012

DB Path

C:\ProgramData\COPA-DATA\SQL2012Y

User

zenOnSry

Password

Tools

Zzenon




Entry

Read from
zenDB.ini

Clear all fields

SQL instance

DB Path

User

Password

Function

Clicking on the button reads off the settings from the zenDB. ini file and the
following fields are automatically filled:

» SQL instance
» DB Path

» User

» Password

All input field are cleared.
Empty entries are not written to zenDB.ini at registering.
Name of the SQL server instance which should be used.

The name can be entered directly in the input field or can be selected from the
drop-down list.

Note: By clicking on the drop-down list the local computer is searched for
instances which are then listed. The search may take some time.

Path for the SQL database of the zenon projects.
For example: C:\ProgramData\COPA-DATA\SQL\

Attention: Different SQL Servers (for example 2008R2 and 2012) must use
separate paths.

Background: When converting projects the GUID stays the same. If the same
folders are used, both instances overwrite each others database files.

User name for the database.

Necessary rights

In the SQL Server the user must have the following Server roles:
> public

> sysadmin

Password of the user. It is stored encrypted. The entry length is always displayed
with 20 characters regardless of the actual length.

Attention: The encryption is done via the Startup Tool. Therefore you must
carry out the database setting via the Startup Tool.

These settings are saved in the zenDB. ini file.



Database after version 6.51

Setting of the database property before zenon 6.51:

erpeRies_

|

| Read from zenD8.ini J

(

Gear al fisds )

Provider: Prowider

JCLL

DB Path: C:\ProgramData\COPA-DATASOLY

_601;Pers

Tools

Zzenon




Entry

Read from
zenDB.1ini

Clear all fields

Provider

DB Path

A Attention

Function

After a click on the button, the settings from file zenDB. ini are read and the fields

Provider, DB Path are filled automatically.

All input field are cleared.

Empty entries are not written to zenDB.ini at registering.

Connection to the SQL instance. Important information:
> Instance name
»  Used provider
> User name

»  User password

For example:

Provider=SQLNCLI.1;
Password=srv_000;

Persist Security Info=False;

User ID=zenOnSrv;

Initial Catalog=%s;

Data Source=localhost\ZENON_DEV;

Path for the SQL database of the zenon projects.

For example: C:\ProgramData\COPA-DATA\SQL\

Attention: It is necessary that SQL Server 2005 and SQL Server 2008 R2 use

different folders.

Background: When converting projects the GUID stays the same. If the same folders

are used, both instances overwrite each others database files.

The entry for Provider differs in this dialog from the entry in the zenDB.ini.

Dialog: String starts with Provider=. . .

zenDB. ini: String starts with Provider=Provider=. ..
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Extras

Here, you create ActiveX controls (*.ocx) or COM servers (*.dll) which should be registered together
with the respective zenon version. The OSX and DLL can originate from any sources, i.e. they can me
written by yourself or by other manufacturers. Additionally you can define programs which are carried
out before the starting or after the closing the Editor or the Runtime.

General | Database | Extras
Register ocxfdll files
Filename Filepath Add
Execute
Pre Start: | E]
Past Start: E]
Ok ] [ Cancel ]

REGISTRATION ACTIVEX CONTROLS - COM SERVER

All files listed here are automatically registered together with the respective zenon version -
independent of the central setting (on page 64) register.
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Filename/Filepath List of all files to be registered

Add opens the Windows dialog for selecting a file to be registered. There you can
select OCX or DLL files individually and add them to the list. First select the
wanted file type (OCX or DLL).

All files are saved with path information. If the path changes, remove the link
with Remove and create a new one.

Remove Removes all selected entries from the selection list of the files to be
registered.

PRE-START AND POST-START PROGRAMS

With Pre Start and Post Start, you can define programs and batch files which should be executed before
starting or after closing zenon.

Pre Start External program that should be started, before the Editor or Runtime is
started.

Post Start External program that should be started, after the Editor or Runtime is
closed.

Attention: Post Start is only executed if the Read back the INI
settings (ltem->Properties->General) option was activated.




2.5.3 Message at registering

POP-UP AT REGISTERING

Message

You have changed the IPv6 setting. All
internal TCP/IP connections will be
switched to IPv6/IPv4.

To ensure that all affected components

are properly switched you have to restart

the computer! You will also have to
change this setting on all connected
station!

Do you really want to apply the change?

General network configuration settings
will be changed.

You have to restart the runtime to apply
the changes!

Attention: Do not forget to adept the
settings on other stations as well.

Apply settings.

Are you sure this is your intent?

MESSAGE AT REGISTERING

Meaning

You change the settings for the IP protocol from
IPv4 to IPv6 or vice versa.

After the changes you must restart the computer for
all services to be adapted accordingly. The change
must also be carried out on all connected stations.

These changes are written to zenon6.ini or
zenon. ini together with the registration and
overwrite any manual configurations.

You change general settings (on page 68) in the
same ways as time outs.

These changes are written to zenon6. ini or
zenon. ini together with the registration and
overwrite any manual configurations.

You must adapted changed settings for all Runtimes.

When registering the services, all steps are displayed in their own window which automatically closes
after 4 seconds. When an error occurs, an warning message informs you about the cause. After
confirming the message the procedure is canceled. zenon is not started. Possible error messages:
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Message

Couldn’t find
zenNetSrv
Service!

zenNetSrv.exe
still running!

Couldn’t find
zenNetSrv
Service!

zenNetSrv.exe
still running!

254

Reason

File zenNetSrv.exe is missing from the
zenon program folder or a wrong version is
available.

The service zenNetSrv.exe could not be
stopped.

File zenNetSrv.exe is missing from the
zenon program folder or a wrong version is
available.

The service zenSysSrv.exe could not be
stopped.

Command line

Hint

Most of the time the fastest an safest

solution is a new installation of zenon.

It is possible that a security tool is
running on the computer which
prevents the access.

Most of the time the fastest an safest

solution is a new installation of zenon.

It is possible that a security tool is
running on the computer which
prevents the access.

You can also operate the Startup Tool using the command line. For this file zenon_Startup.exe must be
present in the system path. You can find the file

» with Vista/7/8 inthe C:\Program Files\Common Files\COPA-DATA\STARTUP

folder

In the commando line you can:

» create new entries (on page 84)

» reorganize (on page 87) existing entries (e.g. after older versions have been deleted)

» register (on page 87) entries

Parameter

The input is started with zenon_Startup.exe followed by a Parameter and possible field names.

Parameter:
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Parameter Function

-new creates a new entry.
-reorg checks and reorganizes existing entries
-reg registers services

USING SEVERAL PARAMETERS AT ONCE:

Field name

yes, list see also new (on
page 84)

not available

Name of the
entry

Return value

Oorl

None

None

It is possible to use several parameters at once. If several -new parameters are used at once, the return

value cannot be evaluated unambiguously.

In general when several parameters are used, it is proceeded in the following order:

1. -new: Create new entries.

2. -reg: Register the stated entry.

3. -reorg: Remove all invalid entries for deleted zenon versions.

new - Creating new entries

Parameter -new is used for creating new entries. It needs at least two field names:

» NAME as unigue name for the entry

If the name of the entry is already available, no entry is created.

» PATH as path in which zenon is stored.

SYNTAX

The syntax is constructed as follows: zenon_Startup.exe -> Parameter > Field name="TEXT"

1. =zenon_Startup.exe

2. Space
3. TAG
4. Space
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5. Field name

6. =character

7. opening quotation marks
8. Text

9. closing quotation marks

= Example

zenon_Startup.exe -new NAME="New entry" PATH="C:\Example Directory\zenon"

FIELD NAME

The following field names can be used:
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NAME Unique name of the entry.
For example: NAME="Test"

PATH The user path in which zenon is saved.
For example: PATH="C:\Program Files (x86)\COPA-
DATA\zenon 7.10 SPO"

PATH64 The application path, in which the 64-bit version of zenon is located.
For example: PATH="C:\Program Files\COPA-DATA\zenon
7.10 SPO"

PROJECT RT

Name of the Runtime project which should be started.

For example: PROJECT_RT="Test project"

PROJECT_RT_PATH

The Runtime folder of the project (see PROJECT RT).

For example:
PROJECT_RT_PATH="C:\Users\Public\Documents\zenon p
rojects\test projekt"

PROJECT_ED

The project which should be activated in the Editor.

For example: PROJECT_ED="Test project"

WSP

The workspace with which the Editor should be loaded.

For example:
WSP="C:\Users\Public\Documents\zenon projects\DE
MO622.WSP6"

SQLSRV

Name of the SQL Server which should be used by the Editor.

For example: SQLSRV="MSSQLSZENON_DEV"

PROVIDER

Provider string for the initialization of the SQL connection.

For example:

PROVIDER="Provider=SQLNCLI.1l; Password=000; Per
sist Security Info=False;User
ID=zenOnSrv;Initial Catalog=%s;Data
Source=localhost\ZENON_ DEV;"

DBPATH

Path for the SQL database which should be used

For example: DBPATH="C: \ProgramData\COPA-DATA\SQL\"




PRESTART - Program call which is executed before the start of the Editor or the
Runtime or the registering of this version.

For example: PRESTART="C:\zenon versions\zenon
6.50\DlIs\zenVNCCli.exe"

POSTSTART - Program call which is executed after the Editor is closed.

For example: POSTSTART="C:\zenon versions\zenon
6.50\DlIs\zenVNCCli.exe"

Attention: Post Start is only executed when in the Startup Tool or in
Startup.ini option Read back the INI settings (tem ->
Properties -> General) is activated.

The field names are separated by spaces.

¥ Info

Paths with spaces must always be put between parentheses.

RETURN VALUES

0 - execution faultless

1 - entry could not be created

reorg - reorganizing of entries

Parameter -reorg checks all entries whether the linked zenon version is still available in the file system.
If the application files are no longer found, the entry is finally deleted from the Startup Tool.

The command does not provide a return value. After execution the Startup Tool is started.

Example: zenon Startup.exe -reorg

reg - register entries

The -reg parameter registers all necessary services in the folder of the stated entry. It is called up via:

» -reg"Name of the entry"
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If the Startup Tool has already been started, nothing is registered but the Startup Tool is moved to the
foreground.

The command does not provide a return value.

E Example
zenon_Startup.exe -reg "Version 6.50"

registers version 6.50.

Prerequisite: there is an entry with this name in the Startup Tool.

2.6 System Information Collector
When solving problems, COPA-DATA Support may ask for the relevant data about your operating system

and zenon. The easiest way for you to create this data is in an automated manner with the System
Information Collector and then sending this to Support.

2.6.1  Starting the System Information Collector

To start the Ssystem Information Collector:

1. Inthe Windows Start Menu, navigate to All Programs-> COPA-DATA

2. Click on system Information Collector
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3. The System Information Collector starts

-
#& System Information Collector

i File Edit View Help

o Full
1'._{') Collect all system and Scada related information.
Ful
System
gi Collect only system related information,
System
Scada
& Collect only Scada related information (do not include dump files).
Scada
Scada with dumpfiles
E Collect only Scada related information {include dump files).
Scada

=

(5]

MENU AND TOOL BAR

MENU

The following options are available to you in the menu:

» File
e Home: Opens the Start window.
e oOpen: Opens a saved report
e save: saves the currently-displayed report as a ZIP file
e Exit: closes the system Information Collector
» Edit
e copy: copies highlighted text to the clipboard
e Find: Opens a dialog to search the current report

>  View

e Expand: expands all nodes
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e Collapse: closes all nodes

> Help

e about: INformation on the program version

With the exception of Exit and about, all options are available via the tool bar.

TOOL BAR
[Rey=N = N e
Symbol Description
Home Opens the Start window.
Open Opens a saved report.
Save Saves the currently-displayed report as a ZIP file.
Copy Copies highlighted text to the clipboard.
Find Opens a dialog to search the current report
Expand Expands all nodes.
Collapse Closes all nodes.

2.6.2  Collecting information

To collect information in an automated manner:

1. Start (on page 88) the system Information Collector

2. Select one of the four options by clicking on the corresponding button
e Full: collects information about the system and zenon and includes dump files
e system: cOllects information about the system only

e scada: collects information about zenon, without dump files



e scada with dumpfiles: collects information about zenon and includes dump files

& System Information Collector =&

: File Edit View

. Full
% Collect all system and Scada related information.
Ful
System
E’;(i Collect only system related information,
System
Seada

Collect only Scada related information (do not include dump files).

)

Scada with dumpfiles
Collect only Scada related information (include dump files).

m‘

3. The system Information Collector creates a report with the desired information

[ [E=E——)
System Info
@ Processes
Cancel sqlservr.ene
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4. The completed report is displayed in the main window

#& System Information Collector il

i File Edit

& Full P
(=5 System Info F
{55 Console Ful
= {5 Files
(=-{§@ Registry _
555 Scada Name ull .
Description Collect all system and Scada related information 3
Time (UTC) 201210119 08:18:33 438
Summary
Projects

Qy Scheme files for version 7000 Complete

sSaL

Qy RoS Seae Connection to ATSZG-WKS007\:ZENON_2008R2 established
Attached files

LOG121005103434.TXT & C\ProgramData\COPA-DATAILOGILOG 121005103434 TXT

2.6.3 Using the information
All information collected is displayed in the System Information Collector. You can:
» Save the report

» Navigate through the report and search for certain information
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» Highlight selected information and copy it to the clipboard

-
#& System Information Collector =l

i File Edit View Help

& Full

4150 System Info
#1-{58 Console ProgramData
31 {5 Files

-l Registry ——
-1-{55 Scada Name rogramData

= saL valug C:\ProgramData\COPA-DATAzenon 700\
-3 Installed instances
-] SQL Server

= D Versions
- AN versions o ; ; . - I—
" [1] Version7000 System Information + 1.0 (c)Ing Pun_on:c:r-;-_rf.‘_-d-

= Directories SRl
i\ =] ProgramData
i @ ]2 ProgramDir
! @-]H LogDirectory
+ |_| DumpFiles

i ;_ SqlConnection

SAVING A REPORT

To save a report:
1. Click on the save symbol or the save command in the File menu
2. the dialog for selecting a folder and file name is opened

3. Thereportis saved as a ZIP file

SAVING SELECTED INFORMATION
To saved selected information only:
1. highlight the relevant information.
2. Click on the copy symbol or the copy command in the Edit menu
3. The selection is saved to the clipboard
4. Insert the content into a text file and save this

5. Repeat this process for further selected information
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2.6.4 Forward report to COPA-DATA

The report can, depending on its size, be forwarded as an e--mail or uploaded to a defined save location
to COPA-DATA. You can find out details on how you forward the report and which online save location
you can use for this from your COPA-DATA Support contact.
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